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Perhaps	you	want	to	change	the	background	of	your	PDF	into	a	solid	white	or	black	color?	Or	change	the	background	image	with	a	new	image?	If	so,	you	will	be	pleased	to	know	this	is	actually	easy	to	do	today,	because	most	PDF	tools	have	an	impressive	feature	to	add	or	change	background	in	a	PDF	document.Adobe	Acrobat	isnt	the	only	company
working	on	converting	PDF	background	colors,	in	this	guide,	we	will	look	at	different	ways/tools	to	change	PDF	background	color	from	black	to	white,	from	white	to	black,	etc.,	so	you	can	print	or	share	the	PDF	in	the	look	you	want.	Change	PDF	Background	Color	from	Black	to	White,	etc.	in	Adobe	AcrobatAs	common	as	PDFs	are,	Adobe	Acrobat	Pro
is	actually	the	apple	of	many	PDF	users	eye,	it	creates	PDF	and	keeps	making	PDF	stronger	and	stronger.	The	days	of	downloading	a	separate	program	to	edit	a	PDF	file	has	come	for	long,	most	of	us	trust	more	on	a	robust	standalone	PDF	tool	like	Adobe	Acrobat,	it	does	jobs	within	seconds	or	minutes,	lets	users	dive	into	all	kinds	of	PDF	with	full
control.It	can	edit	anything	in	your	PDF	file,	including	texts,	images,	urls,	media	objects,	fields,	backgrounds,	metadata.	Any	time	somebody	send	you	a	PDF	file	to	sign	or	review,	you	can	get	it	back	soon.	Not	only	change	black	PDF	background	to	white,	or	convert	white	PDF	background	to	black,	it	can	change	to	all	kinds	of	solid	color	from	the	color
palette,	even	you	can	use	a	file	as	background	image.It	does	more	than	you	might	think,	just	have	a	7-day	free	trial	to	evaluate	all	its	features	and	you	will	know	how	good	it	is.NOW,	change	PDF	background	color	from	black	to	white,	etc.	in	Adobe	AcrobatGrab	a	free	trial	of	Adobe	Acrobat	Pro,	install	and	fire	up	the	app.Open	the	PDF	in	Acrobat.Head
to	Edit	PDF.Head	to	More>	Background>	Update.From	color	and	choose	the	background	color	as	white,	or	others,	click	OK.Hit	Close,	then	click	the	Save	button.In	the	case	that	the	background	color	in	your	PDF	is	not	added	with	Adobe	Acrobat,	Acrobat	wont	be	able	to	detect	and	update	the	color,	but	we	still	have	a	solution	for	this	case.Open	PDF
in	Adobe	Acrobat,	head	to	Edit	PDF.	All	the	contents	in	the	PDF	turn	to	be	selectable,	select	the	background	and	delete	it	to	remove	the	original	background	color	first.Then	head	to	More>	Background>	Add,	choose	a	background	color,	like	White,	or	others.Save	the	file	lastly.A	tip	to	change	background	color	in	a	scanned	PDFOpen	the	scanned	PDF
in	Adobe	Acrobat,	head	to	Scan	&	OCR>	Recognize	Text>	In	This	File,	recognize	this	file	to	make	the	file	selectable.Head	to	Edit	PDF,	select	the	background	and	remove	it.Head	to	More>	Background>	Add,	change	the	background	to	any	color	you	want	and	continue	with	OK.Hit	Save.Also,	this	is	the	tutorial	video	you	want	watch	to	convert
background	color	in	your	PDFs	with	Adobe	Acrobat,	starting	from	00:17,Change	PDF	Black	Background	to	White	for	Printing	without	AcrobatFoxit	is	a	supercharged	alternative	to	Adobe	Acrobat	if	you	cannot	fit	yourself	in	Acrobats	workflow.	It	looks	like	Microsoft	Office	Word,	with	ribbons	on	the	top	and	secondary	tools/options	showed	below	when
activated.It	lets	you	create,	edit,	convert,	compare,	flatten,	review,	sign,	fill	and	protect	your	PDFs.It	uses	a	similar	concept	as	Acrobat	to	change	PDF	background	color.NOW,	change	PDF	black	background	to	white	for	printing	without	Acrobat:Open	the	PDF	in	Foxit.Head	to	Organize>	Background>	Update.From	color,	choose	White,	or	any	color	to
change	the	current	background	color	in	Foxit.Hit	OK,	then	hit	Save	button.	How	to	Convert	PDF	Background	Color	to	White	Online	Free?Even	though	we	knew	or	said	some	nice	things	about	standalone	programs	to	change	the	background,	you	or	some	others	might	still	prefer	to	try	online	tool	first,	yes,	it	is	totally	understandable,	I	was	the	same
before.	But	there	is	few	tools	available	in	our	web	browser	to	change	PDF	background	colors,	WorkinTool	(formerly	pdf2eveything)	is	a	solid	option.	If	it	disappoints	you,	you	can	go	ahead	with	a	smallpdf	PDF	to	Word	converter	and	change	the	background	color	in	Word.WorkinToolThis	web	application	lets	users	to	convert	PDF,	video	and	image
online,	also	offers	a	lot	of	standalone	utility	tools	such	as	file	compressor,	audio	recorder,	data	recovery	It	can	change	PDF	background	color	to	white	or	black,	or	others	with	ease.	But	the	file	should	be	within	0.5MB,	and	only	4	files	can	be	processed	at	the	same	time.	And	one	more	thing	to	remind,	it	may	pause	color	converting	for	server	issues,	you
can	re-upload	the	file	and	try	again.NOW,	convert	black	background	to	white	PDF	online	free:Navigate	to	this	webpage:	the	PDF	file.Select	the	white	background	color	you	want	to	change	to.Click	Convert.Then	download	the	PDF	with	the	selected	background	color.SmallpdfFor	PDF	with	a	background	color	or	image	existed,	WorkinTool	sometime
fails	to	change	it,	then	we	can	convert	the	PDF	to	Word,	then	add	a	background	color	as	we	want	to.Navigate	to	smallpdf.com/pdf-converter,	upload	the	PDF	file.Choose	to	convert	to	Word,	then	download	the	file.Open	Word	file	in	MS	Word,	head	to	Design>	Page	Color,	choose	a	color.Export	the	Word	file	as	PDF	again.	Best	Free	PDF	Background
Color	Changer	App	2025Do	you	want	any	open	source	PDF	background	color	change	app,	so	you	can	do	the	job	for	free?	Luckily,	we	have	it.	LibreOffice	comes	in	with	a	lot	of	surprises.It	is	used	for	editing	documents	like	Word,	Excel,	PowerPoint,	PDF	and	so	on	on	Windows,	macOS.	It	is	as	powerful	as	Microsoft	Office	suite	but	serves	for	free.	With
its	Print	tool,	we	can	print	a	PDF	with	black	&	white	color,	the	printout	comes	with	black	font	and	white	background.	However,	LibreOffice	cannot	change	the	background	color	in	some	PDFs,	it	seems	to	have	something	with	how	the	PDF	is	originally	created.NOW,	use	this	PDF	background	color	change	app	to	convert	yours:Get	this	free	copy	of
LibreOffice,	install	and	fire	it	up.Open	the	PDF	with	it.Hover	to	File>	Print.Go	to	LibreOffice>	Color,	tick	Black	&	White.Choose	Save	as	PDF,	the	black	background	in	the	PDF	is	now	changed	to	white.	Change	PDF	Background	Color	in	Mac	PreviewThe	default	PDF	tool	on	macOS	is	Preview,	though	there	is	room	for	it	to	go	stronger,	but	it	isnt	bad,	as
least,	it	offers	a	free	solution	to	change	PDF	background	color.	But	to	note,	it	only	changes	the	windows	background	when	you	viewing	PDFs	in	Preview:Open	the	PDF	in	Preview,	head	to	Preferences.Under	General	tab,	choose	the	color.If	this	is	not	what	you	want,	you	can	copy	and	paste	the	PDF	file	to	Word,	then	adjust	the	formatting	and	change
background	color,	finally	save	the	file	as	PDF.It	is	hard	to	pick	the	best	from	dozens	of	choices,	but	we	have	shortened	the	list	for	you,	all	you	should	do	is	to	have	a	try	on	your	machine	and	keep	the	one	gets	your	job	done	the	best.Anyone	can	write	a	Trustpilot	review.	People	who	write	reviews	have	ownership	to	edit	or	delete	them	at	any	time,	and
theyll	be	displayed	as	long	as	an	account	is	active.We	champion	verified	reviewsCompanies	can	ask	for	reviews	via	automatic	invitations.	Labeled	Verified,	theyre	about	genuine	experiences.Learn	more	about	other	kinds	of	reviews.We	use	dedicated	people	and	clever	technology	to	safeguard	our	platform.	Find	out	how	we	combat	fake	reviews.We
show	the	latest	reviewsLearn	about	Trustpilots	review	process.We	encourage	constructive	feedbackHere	are	8	tips	for	writing	great	reviews.Verification	can	help	ensure	real	people	are	writing	the	reviews	you	read	on	Trustpilot.Offering	incentives	for	reviews	or	asking	for	them	selectively	can	bias	the	TrustScore,	which	goes	against	our
guidelines.Take	a	closer	look	Generally	speaking,	PDF	files	have	a	white	background	and	can	easily	display	text.	However,	users	are	able	to	change	PDF	background	color	or	add	an	image	to	the	background	of	the	PDF	file	easily	as	well.	Wondering	how	to	change	the	PDF	background	color?	We'll	show	you	how	to	easily	accomplish	this	with
Wondershare	PDFelement	-	PDF	EditorWondershare	PDFelementWondershare	PDFelement,	which	can	add,	edit	or	even	remove	PDF	background.	Besides	changing	the	background	color	of	PDF,	PDFelement	can	also	change	text	color,	text	font,	images,	and	more	on	PDF.	Moreover,	there	is	also	an	online	way	to	change	the	background	color.	How	to
Change	PDF	Background	ColorOpen	a	PDF	document	by	PDFelement,	click	the	Edit>Background	button,	then	select	the	Update	Background	option.	You	can	set	the	background	color,	opacity,	page	range,	etc.	After	setting	these,	click	the	File>Save	button	to	save	the	PDF	document.Step	1.	Open	PDF	File	Needed	to	Change	Background	ColorLaunch
PDFelement	and	click	on	"Open	files"	within	the	"Home"	tab.	Now,	select	the	PDF	file	that	you	wish	to	open.Step	2.	Change	PDF	Background	ColorAfter	opening	the	PDF	file,	click	on	the	"Edit"	tab,	as	shown	in	the	screenshot	below.	Here,	you	will	find	a	"Background"	button.	You	will	find	two	options	for	the	background.	You	can	either	add	a	new
background	or	update	the	already	present	background	of	your	PDF	file.	If	you	need	to	change	the	existing	background,	click	the	"Update	Background"	option.	G2	Rating:	4.5/5	|100%	Secure	Then,	in	the	pop-up	window,	you	need	to	click	the	Color	icon	and	select	the	color	you	like	and	preview	the	new	background	on	the	right.	You	also	can	select	the
page	range	for	applying.	Once	done,	you	need	to	click	the	"Apply"	button	to	apply	the	new	background	color.Step	3.	Save	the	PDF	FileClick	"Save	As"	under	the	"File"	tab	to	save	the	changes	you've	made.Tip	How	to	Change	PDF	Background	Color	to	WhiteSometimes,	you	need	to	change	PDF	background	color	to	white	for	printing,	PDFelement	can
help	you	with	that.	Here	are	the	steps.Step	1.	Open	a	PDF	file	in	PDFelement,	go	to	"Edit"	>	"Background".Step	2.	Select	"Update	Background",	and	select	white	from	the	color	palette	to	change	the	background	color	to	solid	white.	Alternatively,	you	can	adjust	the	opacity	to	0%	so	that	the	background	will	be	transparent.Step	3.	Click	the	Save	button
to	save	the	background	change.	Or	print	the	PDF	by	clicking	the	Print	button.Professional	Tips:Carefully	select	the	background	color	to	ensure	the	text	shows	up	in	the	final	PDF	file.Don't	add	an	overly	complicated	image	as	the	background.	Part	2:	How	to	Change	PDF	Background	Color	on	MacMac	users	usually	look	for	tools	to	help	them	manage
their	PDF	documents.	PDFelement	for	Mac	provides	some	of	the	best	features	in	editing	documents	to	cut	their	search	short.	Moreover,	it	makes	a	complete	package	to	change	PDF	background	color	with	ease.	To	understand	the	process,	you	need	to	look	into	the	steps	provided	as	follows:	G2	Rating:	4.5/5	|100%	Secure	Step	1.	Upload	PDF	File	to
Change	Background	ColorYou	are	advised	to	download	and	install	PDFelement	for	Mac	across	your	device.	Once	done,	launch	and	tap	on	Open	to	import	the	required	document.Step	2.	Select	Add	or	Edit	BackgroundFollowing	this,	access	the	Tool	tab	on	the	next	screen	and	select	the	option	of	Add	or	Edit	Background	from	the	drop-down	menu.	A	new
window	opens	up	on	the	screen.Now,	you	can	click	the	"Edit	Background"	button	and	tap	on	the	pencil-like	icon	at	the	bottom	of	the	background	template.Step	3.	Change	PDF	Background	ColorYou	need	to	navigate	to	the	"Color"	section	on	the	new	screen	and	select	the	color	from	the	available	color	palette	as	you	desired.	After	selecting,	tap	on	the
"Save"	button.	Once	done,	click	"Apply"	in	the	"Edit	Background"	window	and	save	the	document.	G2	Rating:	4.5/5	|100%	Secure	Part	3:	How	to	Change	PDF	Background	Color	OnlineDownloading	software	and	platforms	can	be	a	hassle	for	many	users	searching	for	making	small	edits	to	their	documents.	For	this,	you	can	consider	working	with	online
platforms.	To	change	PDF	background	color	online	using	Google	Docs,	you	need	to	follow	the	below-mentioned	steps.Step	1:	Launch	Google	Docs	on	any	browser	across	your	device	and	open	the	PDF	document	you	wish	to	edit.Step	2:	Once	opened,	you	need	to	navigate	to	the	File	tab	and	select	Page	Setup	from	the	options	provided	in	the	drop-down
menu.Step	3:	On	the	new	screen,	select	the	color	from	the	color	palette	or	custom	design	color	to	change	the	PDF's	background.	Tap	"OK"	over	completion	to	change	the	background	color	successfully.	Part	4:	The	Best	Solution	to	Change	PDF	BackgroundMany	solutions	help	you	change	PDF	background	color	across	PDF	documents.	As	discussed	in
the	article,	there	are	online	and	offline	solutions	to	cater	to	the	requirement.	Talking	about	online	solutions,	they	save	users	from	unnecessary	downloads	and	provide	a	straightforward	interface	to	work	with.On	the	other	hand,	offline	platforms	make	work	proficient	with	the	variety	offered	in	editing	documents.	As	we	look	into	PDFelement,	the
platform	allows	users	to	change	backgrounds,	add	backgrounds,	edit,	and	even	remove	them	with	ease.	This	makes	it	an	extremely	impressive	option	among	online	and	offline	PDF	editors.	FAQs	about	Changing	the	Background	Color	of	PDFUnfortunately,	Adobe	Reader	does	not	have	the	capability	to	change	the	color	of	a	PDF	directly.	You	would
need	to	use	PDF	editing	software	such	as	Wondershare	PDFelement,	and	Adobe	Acrobat	Pro.	With	those	programs,	you	can	change	the	background	color,	text	color,	or	image	color	of	a	PDF.	Just	select	the	object	or	text	you	want	to	change	the	color	of	and	use	the	color	picker	tool	to	select	a	new	color.To	change	the	color	of	an	entire	PDF	document,
you	can	use	Wondershare	PDFelement.	Open	the	PDF	file	in	PDFelement,	then	select	"Edit"	from	the	toolbar.	Next,	click	"Background"	and	choose	the	color	you	want	to	change	to.	Finally,	click	"OK"	to	apply	the	changes	to	the	entire	PDF	document.	Free	Download	or	Buy	PDFelement	right	now!	Free	Download	or	Buy	PDFelement	right	now!	Try	for
Free	right	now!	Try	for	Free	right	now!	If	you	want	to	add	a	background	color	to	a	page,	please	check	this:	Let	us	know	if	you	have	further	questions.	Be	kind	and	respectful,	give	credit	to	the	original	source	of	content,	and	search	for	duplicates	before	posting.	Learn	more	Are	you	looking	for	some	effective	ways	to	change	PDF	background	color?	If	so,
you	come	to	the	right	place.	Here,	this	article	from	MiniTool	PDF	Editor	offers	a	detailed	guide	on	how	to	change	PDF	background	color.	Just	follow	it	to	do	that.If	you	want	to	add	a	little	personalization	to	your	PDF	documents,	an	easy	way	is	to	change	PDF	background	color.	Not	only	will	this	make	your	document	stand	out,	but	it	will	also	improve
readability	and	reduce	eye	strain.	In	addition,	you	may	encounter	that	some	types	of	paper	cannot	print	in	color	when	printing	PDF,	so	you	also	need	to	change	PDF	background	color.Read	on	and	learn	how	to	change	background	color	of	PDF	files	in	a	few	easy	steps	with	two	offline	programs	and	an	online	tool.PDF	(Portable	Document	Format)	is	one
of	the	most	popular	file	formats.	It	is	mainly	used	for	academic	papers,	journals,	handbooks,	company	contracts,	study	material,	etc.	Sometimes,	you	may	need	to	change	background	color	of	PDF	to	improve	readability.How	to	change	PDF	background	color	on	Windows?	You	can	try	the	following	ways.To	help	you	change	background	color	of	PDF	on
Windows,	we	recommend	MiniTool	PDF	Editor	that	is	a	handy	PDF	editor	for	Windows.	It	has	a	series	of	editing	tools	that	allow	you	to	modify	all	text,	images,	links,	and	other	elements	in	PDF	files,	including	customizing	the	background	color	of	PDF	files.The	Background	feature	in	MiniTool	PDF	Editor	not	only	allows	you	to	change	PDF	colors,	but
also	supports	uploading	images,	adjusting	appearance	and	position,	and	applying	to	dedicated	pages.Whats	more,	this	software	can	be	able	to	solve	almost	all	PDF-related	problems,	such	as	writing	and	drawing	on	a	PDF;	adding	or	removing	notes,	images,	shapes,	stamps,	attachments,	watermarks,	and	links	to	PDF;	splitting/merging/compressing
PDFs;	converting	PDF	to	many	other	file	formats;	and	so	on.In	this	part,	we	will	show	you	how	to	change	PDF	background	color	using	MiniTool	PDF	Editor.	Here	is	the	guide:Step	1:	Click	on	the	following	Download	button	to	get	the	installation	package,	double-click	on	the	executable	file,	and	follow	the	on-screen	instructions	to	install	MiniTool	PDF
Editor	on	your	PC.MiniTool	PDF	EditorClick	to	Download100%Clean	&	SafeTips:	MiniTool	PDF	Editor	offers	you	a	7-day	free	trial	to	access	all	its	features.	Once	the	trial	expires,	you	need	to	upgrade	to	the	Pro	Edition	if	you	want	to	go	on	using	many	advanced	features.	To	know	more	details,	you	can	refer	to	the	MiniTool	PDF	Editor	comparison.Step
2:	Launch	this	software	to	enter	its	main	interface	and	open	the	PDF	file	that	you	want	to	change	its	background	color.Step	3:	Go	to	the	Edit	tab	from	the	top	toolbar	and	click	on	the	Background	arrow	button.	Then	click	on	Update	Background.Step	4:	In	the	pop-up	Update	Background	dialog	box,	click	on	the	Color	drop-down	menu	to	choose	the
background	color	you	want	to	change.	Or,	you	can	use	the	Color	picker	to	select	a	color	as	well.Step	5:	If	necessary,	there	are	more	settings	you	can	do	within	the	Update	Background	dialog	box.Appearance:	You	can	adjust	the	Rotation	degree	of	the	background	(-45,	0,	45,	or	other	degrees),	and	the	Opacity	percentage.	In	the	Scale	field,	you	can	type
a	number	to	resize	the	background	color	area.Position:	It	offers	Vertical	and	Horizontal	positions.	First,	choose	Top,	Center,	or	Bottom	for	the	Vertical	position	and	choose	Left,	Center,	or	Right	for	the	Horizontal	position.Page	Range:	You	can	decide	to	change	the	background	color	to	all	pages	or	partial	pages.	After	deciding	the	page	range,	you	can
decide	to	change	the	background	to	odd	pages,	even	pages,	or	all	pages	within	the	Page	Range.Step	6:	Once	done,	click	on	OK	and	the	PDF	file	background	color	is	changed.How	to	change	PDF	background	color?	If	you	are	still	looking	for	the	method	for	that,	MiniTool	PDF	Editor	is	really	worth	trying.	It	includes	lots	of	features	to	make	PDFs
perfect.Click	to	TweetAdobe	Acrobat	Reader	is	one	of	the	popular	PDF	editing	tools.	It	can	also	change	background	color	of	PDF.	Here	is	the	guide:Step	1:	Launch	Adobe	Acrobat	Reader	and	open	the	PDF	file	that	you	want	to	change	the	background	color.Step	2:	Go	to	the	Tools	tab	and	select	Edit	PDF.Step	3:	Select	More	>	Background	>	Add.Step
4:	In	the	Source	section,	select	the	color	you	like	in	From	color	and	click	OK	to	apply	your	changes.Google	Docs	is	the	last	way	I	recommend	to	you.	It	is	an	online	tool.	For	those	who	don't	have	a	desktop	PDF	editor	installed	on	their	computer,	using	an	online	tool	is	a	good	option.	It	can	help	you	change	background	color	of	PDF.	Here	is	the
guide:Step	1:	Launch	Google	Docs	on	your	browser	across	your	device	and	open	the	PDF	file	that	you	want	to	change	the	background	color.Step	2:	Once	opened,	go	to	the	File	tab	and	select	Page	Setup	from	the	options	provided	in	the	drop-down	menu.Step	3:	On	the	pop-up	screen,	select	the	color	you	prefer	in	the	Page	color.	Then	click	on	OK	to
change	PDF	background	color	successfully.In	this	article,	we	have	introduced	three	methods	to	change	background	color	of	PDF,	covering	two	Windows	desktop	programs	and	an	online	tool.	You	can	choose	one	of	them	to	do	that	according	to	your	needs.If	you	have	any	thoughts	about	this	topic,	share	them	with	us	in	the	following	comment	area.	For
any	problems	when	using	MiniTool	PDF	Editor,	you	can	contact	us	by	sending	an	email	to[emailprotected].	Well	make	a	quick	reply	to	solve	your	problems.Removing	a	background	can	leave	a	document	looking	a	bit	bare.	If	youd	prefer	a	splash	of	color	or	a	minimalist	design,	its	easy	to	add	one	back	in.Tips	for	Better	PDF	Background
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